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The Mix Fertilizers  Menu 

 

Smart! has six options for mixing fertilizers; three calculation methods are by Water Content  

and three are by Amount of fertilizers to be applied. 

Water Content is often used for soil-less media and Amount  is often used for open field. 

Calculation by Water Content is described below and Calculation by Amount is described on 

page 32. 
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Calculation By Water Content 

 

Use Water Content  if you work according to nutrient concentrations in the irrigation water. 

 

You have 3 methods of calculation to choose from: Method 1, Method 2 and Method 3. 

 

Method 1  -  A recipe is produced based on your required target values for irrigation water. 

Method 2  – Irrigation water content is calculated based an actual recipe used. 

Method 3  – A recipe is produced based on concentration of fertilizers in the irrigation water. 
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Mixing Fertilizers By Water Content – Method 1  

 

In this section you will learn how to find the optimal combination and quantities of fertilizers to 

match your target values for the irrigation water.  

 

From the Mix Fertilizers  menu, select By Water Content  > Method 1 . The calculation  

screen is displayed. 

 

 

 

Entering Source Water Content and Target Values  

1.  from the Units  drop down menu select the units for the calculation. You can select either  

     ppm, meq/l or mmol/l. 

 

 

 

2.  Each of the macro nutrients (N, P, K, Ca, Mg ,S) has a drop down menu. Open the drop  

    down menu to select the form of each element (e.g P or P2O5, N-NO3 or NO3). 

                         

3.  In the Source Water  row, enter values for each element, according to your source water  
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     analysis.  

 

 

 

Note that changing the units  or the form  of the elements will automatically convert the value 

you entered accordingly. 

 

4. In the Target Values row, enter your required target values for the irrigation water. 

     

 

 

You can check the ratios between the different elements at any time. To see ratios between 

the different elements press the Report  button at the right bottom corner of the screen or go 

to the navigation bar and select File �> Report.  

 

5. Enter the source water pH , source water EC  and your target irrigation water pH . 

    

 

 

Selecting The Fertilizers to Be Used for The Calcul ation  

After you entered source water content and determined target value for each element, you will 

now select the fertilizers available to you, from the fertilizers in the database. 

 

The fertilizers are divided to liquid fertilizers and solid fertilizers, for convenience purposes. 

 

1. In order to find a fertilizer on the list, you can either use the scroll-down menu or search the 

    fertilizer through the Search Fertilizer box. 

 

 

 

 

 



 �

 

 

 

Note: If the fertilizers you need are not on the list, you can simply add them to the database 

through the New Fertilizer menu (page 58). You can also create your own databases.  

 

 

2. To select a fertilizer from the list, double click it. The fertilizer will then be added to the 

   Selected Fertilizers box. 

 

 

 

 

Note: when you select an acid, you will be asked to enter its concentration (according to 

manufacturer data). 

 

 

To remove a fertilizer from the Selected Fertilizers list, click the check box next to the  

fertilizer and press the Remove button. 

To remove all the fertilizers selected, press the Remove All button. 

 

Calculating The Optimal Mix Of Fertilizers 

3. After you selected the fertilizers to be used, press the Calculate button. 

    Three things then happen: 

    a. Smart! finds the best combination of fertilizers, out of the fertilizers you selected, to reach   

        your target values.  

    b. Smart!  calculates the required concentration in the irrigation water  for each one of  

         these fertilizers. 
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    c . A window opens at the top of the screen, displaying the following information for each 

         element: needed addition, actual addition and the accuracy of the calculation.  

         Estimated irrigation water pH, remained HCO3 in irrigation water and estimated  

         irrigation water EC are displayed at the bottom of this window. 

 

 

 

After you press the Calculate button, you can still change the concentration in irrigation 

water for each fertilizer, as well as remove fertilizers from the list or add fertilizers to the list. 

The displayed results will change accordingly. If needed, adjust the values to a result that 

best fits your needs. 

 

The Check button – you may press the Check  button to redisplay the above window in case 

you moved on and closed it. No additional calculations will be made. 

 

The Report  button - press the Report button, to see your water content, ratios between 

elements in the irrigation water as well as EC, pH and SAR. In the Report  form press Details  

to see the contribution of each fertilizer to each element. 

To print this report, press the printer icon  on the top left side of the report form. 

You can open and close the report at any time. The report will change interactively as you 

change your input. 
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Congratulations!  You have just finished the first step of preparing the perfect recipe. 

You now know which fertilizers to use and what their concentration in the irrigation water in 

should be in order to reach your target values. 

 

You will now distribute the fertilizers into the fertilizer tanks. 

 

Press Fill Tanks  to go to the next screen. 

 

The Fill Tanks screen 

After finding the optimal combination of fertilizers and their required concentrations in the 

irrigation water, you will now find the number of fertilizer tanks required, distribute the 

fertilizers into the fertilizer stock tanks and find the amount to be used of each fertilizer. 

 



 	

 

 

Distributing the fertilizers into the fertilizer st ock tanks 

1. In the Min. Temp (C°)  box Determine the water minimum temperature in degrees 

   Celsius. The temperature you set will determine the solubility of the fertilizers, as in the  

   database. Default value is 5°C. 

. 

2. You have two options for distributing the fertilizers into the tanks: 

 

    Distributing the fertilizers automatically (Auto Fill Tanks) 

    Distributing the fertilizers manually (Manual Fill Tanks)      

 

a. Distributing the fertilizers automatically  

Press Auto Fill Tanks . Smart! will automatically distribute the fertilizers into the 

minimal number of tanks according to the built-in mixing rules.  

b. Distributing the fertilizers manually 

1. Press the Manual Fill Tanks button. 

2. From the Number of Tanks drop-down menu, select the number of fertilizer 

    tanks you wish to use. The fertilizer tanks will now open below. 

3. For each fertilizer in the Selected Fertilizers box, check the check-box. From 

the pop-up menu that appears, select Add to tank __ (choose the tank into which 

you want to add the fertilizer) 

4. Repeat the action for all the selected fertilizers on the list. 
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If you make a mixing error (i.e. mix incompatible fertilizers), an error message will pop up, 

explaining the problem.  

 

 

 

An alarm sign will be displayed in the tank as long as the problem is not corrected. 
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You can click the alarm sign at any time to view the problem explanation again. 

 

Adjusting the Injection Ratio and the Tank Volume  

After distributing the fertilizers into the tanks, you will now adjust the Injection Ratio and the 

Tank Volume.  

In this example, let's take a look at Tank 1: 

 

Water  – The water quantity in the tank. If you use only solid fertilizers, the water quantity will 

be equal to the Tank Volume . 

 

Total Liquid Fertilizers – The amount of liquid fertilizers in the tank. The sum of the Water  

and the Total Liquid Fertilizers  is the Tank Volume. 

 

Tank Volume - The default value for the Tank Volume is set to 1000 liter. You may change 

this value to the actual tank volume you use. As you change the Tank Volume the quantities  

of the fertilizers in the tank (in the Volume / mass column ) are calculated accordingly 
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.  

 

Injection Ratio  – Smart! calculated the default value for the injection ratio (units of L/m3) 

according to the required concentration of the fertilizers and their solubility. This default value 

is the minimal injection ratio recommended. In case the calculated minimal value is less than 

0.5 L/m3, Smart! sets the Injection Ratio on 0.5 L/m3, due to practical considerations (it is 

unlikely that the fertilizer injector injects less than 0.5 L/m3). 

 

You may change the default Injection Ratio to fit your fertilization system.  The quantities of 

the fertilizers in the tank will be calculated accordingly. 

 

If you set the Injection Ratio to a lower value than the minimal value recommended, an alarm 

will pop-up, explaining the problem that might arise. 

 

 

 

 

Note: The higher Injection Ratio you use, the less concentrated the solution in the tank is, and 

vice-versa. Therefore, to prevent precipitation in the tanks, it is recommended to set the 

Injection Ratio to a higher value than the minimal Injection Ratio calculated. 

 

Adjust Injection Ratio and Tank Volume in all tanks, according to your irrigation system 

specifications. 
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Congratulations!  You have just created an optimal recipe, specific to your crop's 

requirements. 

 

Let's see some more options you can use, to adjust the recipe to your specific needs: 

 

The Lock Injection Ratio check box 

You can use this option when you dilute liquid fertilizers in the tank (mixing it with water), or 

when you mix solid fertilizers together with liquid fertilizers. 

Check this check box to determine the quantities of Water  in the tank and of Total Liquid 

Fertilizers. The injection ratio is determined by Smart! accordingly. 

 

Moving fertilizers from tank to tank  

You can fertilizers from tank to tank at any time. To move fertilizers from one tank to another, 

simply check the check box next to the fertilizer in the tank. A pop-up menu appears, where 

you can select the tank to which you want to move the fertilizer. 

Smart! will pop-up an error message if this action causes a problem. 

 

  

 

The Default button 

Press the Default button to go back to the default results of Smart! 

 

Changing the Number of Tanks 

You can add or remove tanks at any time. Simply change the number of tanks in the Number 

of Tanks drop-down menu. 

Note that removing tanks, which already contained fertilizers, will bring the fertilizers back to 

the Selected Fertilizers  box. These fertilizers will have to be re-distributed. 
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Printing your recipe 

To print your recipe, press the Print Recipe button. 

A ready-to-print form will open.  

Press the printer icon  to print. 

 

Saving your recipe 

From the File  menu in the Fill Tanks screen, select Save or Save as. 

In the box opened, enter a name for your recipe. 

Your recipe is now saved. 
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Mixing Fertilizers By Water Content – Method 2 

  

In this section you will learn how to find your irrigation water content from an actual 

application of fertilizers and source water. 
 

From the Mix Fertilizers  menu, select By Water Content  > Method 2 . The calculation  

screen is displayed.  

 

 
 

Entering Source Water content  

1.  from the Units  drop down menu select the units for the calculation. You can select either  

     ppm, meq/l or mmol/l. 

 

 
 

2.  The macro nutrients (N, P, K, Ca, Mg ,S) have a drop down menu. Open the drop down 

     menu to select the form of each element (e.g P or P2O5, N-NO3 or NO3). 

 

3.  In the Source Water  row, enter values for each element, according to your source water  

     analysis.  
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Note that changing the units  or the form  of the elements will automatically convert the value 

you entered accordingly. 

4. Enter Source Water pH  and Source water EC . 
 

Selecting the Fertilizers to be used for the calcul ation 

After you entered your source water content, you will now select the fertilizers available to 

you, from the fertilizers in the database. 

The fertilizers are divided to liquid fertilizers and solid fertilizers, for convenience purposes. 

 

1. In order to find a fertilizer, you can either use the scroll-down menu or search the fertilizer  

    through the Search Fertilizer box. 

 

 

 

Note: If the fertilizers you need are not on the list, you can simply add them to the database 

through the New Fertilizer menu (page 58). You can also create your own databases.  

 

 

2. To select a fertilizer, double click it in the database box. The fertilizer will appear in the 

   Selected Fertilizers box. 
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Note: when you select an acid, you will be asked to enter its concentration (according to 

manufacturer data). 

 

 

To remove a fertilizer from the Selected Fertilizers list, click the check box next to the  

fertilizer and press the Remove button. 

To remove all the fertilizers selected, press the Remove All button.  

 

You will now distribute the fertilizers into the fertilizer stock tanks. 

 

Press Fill Tanks  to go to the next screen. 

 

The Fill Tanks screen  

You will distribute the fertilizers into the fertilizer stock tanks and determine the amount of 

each fertilizer and the injection ratio from each tank. You will then be able to produce a full 

report of your irrigation water content. 

 

 

 

Distributing the fertilizers into the fertilizer st ock tanks 

1. In the Min. Temp (C°)  box Determine the water minimum temperature in degrees 

   Celsius. The temperature you set will determine the solubility of the fertilizers, as in the  

   database. Default value is 5°C. 

. 

2. You have two options for distributing the fertilizers into the tanks: 
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    Distributing the fertilizers automatically (Auto Fill Tanks) 

    Distributing the fertilizers manually (Manual Fill Tanks)      

 

c. Distributing the fertilizers automatically  

Press Auto Fill Tanks . Smart! will automatically distribute the fertilizers into the 

minimal number of tanks according to the built-in mixing rules.  

d. Distributing the fertilizers manually 

1. Press the Manual Fill Tanks button. 

2. From the Number of Tanks drop-down menu, select the number of fertilizer 

    tanks you wish to use. The fertilizer tanks will now open below. 

3. For each fertilizer in the Selected Fertilizers box, check the check-box. From 

the pop-up menu that appears, select Add to tank __ (choose the tank into which 

you want to add the fertilizer) 

4. Repeat the action for all the selected fertilizers on the list. 

 

 

 

If you make a mixing error (i.e. mix incompatible fertilizers), an error message will pop up, 

explaining the problem.  
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Entering tanks data: tank volume, fertilizers quant ities, injection ratios 

After you distributed the fertilizers into the tanks, you will now enter the tanks data. 

In this example, let's take a look at Tank 1: 

 

Water  – First, enter the water quantity in the tank. If you use only solid fertilizers, the water 

quantity will be equal to the Calculated Tank Volume . 

 

Fertilizers  Volume/Mass – For each fertilizer in the tank, enter its quantity in the 

Volume/Mass  column (you can use either Kg or grams for solid fertilizers, and Liter or ml for 

liquid fertilizers) 

 

Injection Ratio  – after you entered the water quantity and the fertilizers amounts, enter the 

Injection Ratio  of this tank. 
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Note: As you enter your data, Smart! checks the solubility limitations and calculates the 

reaction between the fertilizers. If a problem arises, Smart! will pop-up a appropriate alarm.  

 

Enter these settings for each one of the tanks. 

 

As you enter your settings, Smart! calculates all the related parameters of your irrigation 

water. You can also see the estimated irrigation water pH, EC and the remained bicarbonate 

in your water. 

 

 

 

The Report  button - press the Report button, to see your water content, ratios between 

elements in the irrigation water as well as EC, pH and SAR. The report will open in a new 

window. In the Report  form press Details  to see the contribution of each fertilizer to each 

element. 

To print this report, press the printer icon  on the top left side of the report form. 

You can open and close the report at any time. The report will change interactively as you 

change your input. 
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Printing your recipe 

To print your recipe, press the Print Recipe button. 

A ready-to-print form will open.  

Press the printer icon  to print. 

 

Saving your recipe 

From the File  menu in the Fill Tanks screen, select Save or Save as. 

In the box opened, enter a name for your recipe. 

Your recipe is now saved. 
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Mixing Fertilizers by Water Content – Method 3  

 

In this section you will learn how to mix fertilizers according to their concentration in the 

irrigation water. 

First you will determine your source water content and the concentration in the irrigation 

water, of each fertilizer that you select; Smart! will instantly calculate your irrigation water 

content. After you reached the desired irrigation water content, with the fertilizers you 

selected, you will then distribute the fertilizers into the fertilizer tanks and determine the 

injection ratio from each one of them. 

 

From the Mix Fertilizers  menu, select By Water Content  > Method 3 . The calculation  

screen is displayed.  

 

 

 

Entering Source Water content  

1.  from the Units  drop down menu select the units for the calculation. You can select either  

     ppm, meq/l or mmol/l. 
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2. Each of the macro nutrients (N, P, K, Ca, Mg ,S) has a drop down menu. Open the drop  

    down menu to select the form of each element (e.g P or P2O5, N-NO3 or NO3). 

 

3.  In the Source Water  row, enter values for each element, according to your source water  

     analysis.  

 

 
 

Note that changing the units  or the form  of the elements will automatically convert the value 

you entered accordingly. 

4. Enter Source Water pH  and Source water EC . 

 

Note : You cannot enter data in the Irrigation Water row (the irrigation water content will be 

calculated later). 

 

 

Selecting The Fertilizers to Be Used for The Calcul ation  

After you entered source water content and determined target value for each element, you will 

now select the fertilizers available to you, from the fertilizers in the database. 

 

The fertilizers are divided to liquid fertilizers and solid fertilizers, for convenience purposes. 

 

1. In order to find a fertilizer on the list, you can either use the scroll-down menu or search the 

    fertilizer through the Search Fertilizer box. 

 

 

 

 

Note: If the fertilizers you need are not on the list, you can simply add them to the database 

through the New Fertilizer menu (page 58). You can also create your own databases.  

 

 

2. To select a fertilizer from the list, double click it. The fertilizer will then be added to the 



 ��

   Selected Fertilizers box. 

 

 

Note: when you select an acid, you will be asked to enter its concentration (according to 

manufacturer data). 

 

 

To remove a fertilizer from the Selected Fertilizers list, click the check box next to the  

fertilizer and press the Remove button. 

To remove all the fertilizers selected, press the Remove All button. 

 

Calculating the irrigation water content 

For each of the fertilizers you selected, enter its concentration in the irrigation water. The units 

used are gram/m3 for solids and Liter/m3 for liquids. 

 

 

 

The Irrigation Water  content, Estimated Irrigation Water pH  and Estimated Irrigation 

Water EC are calculated and displayed instantly. 

 

 

 

The Arrange button - Clicking the Arrange  button will arrange the selected fertilizers in a 

convenient order to facilitate further calculations. Fertilizers which contain a nutrient that other 

fertilizers do not, will appear at the top of the list. 
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The Report  button - press the Report button to see your water content, ratios between 

elements in the irrigation water as well as EC, pH and SAR. In the Report  form press Details  

to see the contribution of each fertilizer to each element. 

To print this report, press the printer icon  on the top left side of the report form. 

You can open and close the report at any time. The report will change interactively as you 

change your input. 

 

 

 

After you entered the concentrations in the irrigation water for all the selected fertilizers, You 

will now distribute the fertilizers into the fertilizer tanks. 

 

Press Fill Tanks  to go to the next screen. 

 

The Fill Tanks screen 

After finding the optimal combination of fertilizers and their required concentrations in the 

irrigation water, you will now find the number of fertilizer tanks required, distribute the 

fertilizers into the fertilizer stock tanks and find the amount to be used of each fertilizer. 
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Distributing the fertilizers into the fertilizer st ock tanks 

1. In the Min. Temp (C°)  box Determine the water minimum temperature in degrees 

   Celsius. The temperature you set will determine the solubility of the fertilizers, as in the  

   database. Default value is 5°C. 

 

2. You have two options for distributing the fertilizers into the tanks: 

 

    Distributing the fertilizers automatically (Auto Fill Tanks) 

    Distributing the fertilizers manually (Manual Fill Tanks)      

 

a. Distributing the fertilizers automatically  

Press Auto Fill Tanks . Smart! will automatically distribute the fertilizers into the 

minimal number of tanks according to the built-in mixing rules.  

b. Distributing the fertilizers manually 

1. Press the Manual Fill Tanks button. 

2. From the Number of Tanks drop-down menu, select the number of fertilizer 

    tanks you wish to use. The fertilizer tanks will now open below. 

3. For each fertilizer in the Selected Fertilizers box, check the check-box. From 

the pop-up menu that appears, select Add to tank __ (choose the tank into which 

you want to add the fertilizer) 

4. Repeat the action for all the selected fertilizers on the list. 
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If you make a mixing error (i.e. mix incompatible fertilizers), an error message will pop up, 

explaining the problem.  

 

 

 

An alarm sign will be displayed in the tank as long as the problem is not corrected. 
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You can click the alarm sign at any time to view the problem explanation again. 

 

Adjusting the Injection Ratio and the Tank Volume  

After distributing the fertilizers into the tanks, you will now adjust the Injection Ratio and the 

Tank Volume.  

In this example, let's take a look at Tank 1: 

 

Water  – The water quantity in the tank. If you use only solid fertilizers, the water quantity will 

be equal to the Tank Volume . 

 

Total Liquid Fertilizers – The amount of liquid fertilizers in the tank. The sum of the Water  

and the Total Liquid Fertilizers  is the Tank Volume. 

 

Tank Volume - The default value for the Tank Volume is set to 1000 liter. You may change 

this value to the actual tank volume you use. As you change the Tank Volume the quantities  

of the fertilizers in the tank (in the Volume / mass column ) are calculated accordingly 
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.  

 

Injection Ratio  – Smart! calculated the default value for the injection ratio (units of L/m3) 

according to the required concentration of the fertilizers and their solubility. This default value 

is the minimal injection ratio recommended. In case the calculated minimal value is less than 

0.5 L/m3, Smart! sets the Injection Ratio on 0.5 L/m3, due to practical considerations (it is 

unlikely that the fertilizer injector injects less than 0.5 L/m3). 

 

You may change the default Injection Ratio to fit your fertilization system.  The quantities of 

the fertilizers in the tank will be calculated accordingly. 

 

If you set the Injection Ratio to a lower value than the minimal value recommended, an alarm 

will pop-up, explaining the problem that might arise. 

 

 

 

 

Note: The higher Injection Ratio you use, the less concentrated the solution in the tank is, and 

vice-versa. Therefore, to prevent precipitation in the tanks, it is recommended to set the 

Injection Ratio to a higher value than the minimal Injection Ratio calculated. 

 

 



 �


Adjust Injection Ratio and Tank Volume in all tanks, according to your irrigation system 

specifications. 

 

Congratulations!  You have just created an optimal recipe, specific to your crop's 

requirements. 

 

Let's see some more options you can use, to adjust the recipe to your specific needs: 

 

The Lock Injection Ratio check box 

 You can use this option when you dilute liquid fertilizers in the tank (mixing it with water), or 

when you mix solid fertilizers together with liquid fertilizers. 

Check this check box to determine the quantities of Water  in the tank and of Total Liquid 

Fertilizers. The injection ratio is determined by Smart! accordingly. 

 

Moving fertilizers from tank to tank  

You can fertilizers from tank to tank at any time. To move fertilizers from one tank to another, 

simply check the check box next to the fertilizer in the tank. A pop-up menu appears, where 

you can select the tank to which you want to move the fertilizer. 

Smart! will pop-up an error message if this action causes a problem. 

 

  

 

The Default button 

Press the Default button to go back to the default results of Smart! 

 

Changing the Number of Tanks 

You can add or remove tanks at any time. Simply change the number of tanks in the Number 

of Tanks drop-down menu. 

Note that removing tanks, which already contained fertilizers, will bring the fertilizers back to 

the Selected Fertilizers  box. These fertilizers will have to be re-distributed. 
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Printing your recipe 

To print your recipe, press the Print Recipe button. 

A ready-to-print form will open.  

Press the printer icon  to print. 

 

Saving your recipe 

From the File  menu in the Fill Tanks screen, select Save or Save as. 

In the box opened, enter a name for your recipe. 

Your recipe is now saved. 

 



 ��

Calculation By Amount  

 

Use calculation by amount whenever you wish to work by a quantitative nutrients application 

(amount/area) to the field. 

You have 3 methods of calculation to choose from: Method 1, Method 2 and Method 3. 

 

Method 1 -  A recipe is produced based on your required target values of daily nutrient  

                   application to the field. 

Method 2 – Daily nutrient application to field is calculated based on an actual recipe used. 

Method 3 – A recipe is produced based on the amount per area of the fertilizers applied.  
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Mixing Fertilizers By Amount – Method 1  

 

In this section you will learn how to find the optimal combination and quantities of fertilizers to 

match your target values for quantitative daily fertilizers application.  

 

From the Mix Fertilizers  menu, select By Amount  > Method 1 . The calculation  screen is 

displayed 

 

 

 

Entering Target Values for nutrient application  

1. Each of the macro nutrients (N, P, K, Ca, Mg ,S) has a drop down menu. Open the drop  

    down menu to select the form of each element (e.g P or P2O5, N-NO3 or NO3). 

                         

 

Note that changing the units  or the form  of the elements will automatically convert the value 

you entered accordingly. 

 

2. In the Target Values row, enter your required target values for the nutrient application to 

    the field. The units used for the calculation are Kg/ha/day. 

    You can check the ratios between nutrients at any time. To see ratios between the different  

    nutrients press the Report  button at the right button corner of the screen, or go to the 

    navigation bar and select File  >  Report . 
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Selecting the Fertilizers to be used for the calcul ation  

After you entered your target value for each element, you will now select the fertilizers 

available to you, from the fertilizers in the database. 

The fertilizers are divided to liquid fertilizers and solid fertilizers for convenience purposes. 

 

1. In order to find a fertilizer, you can either use the scroll-down menu or search the fertilizer  

    through the Search Fertilizer box. 

 

 

 

 

Note: If the fertilizers you need are not on the list, you can simply add them to the database 

through the New Fertilizer menu (page 58). You can also create your own databases.  

 

 

2. To select a fertilizer, double click. The fertilizer will then be added to the Selected 

Fertilizers box. 

 

To remove a fertilizer from the Selected Fertilizers list, click the check box next to the  

fertilizer and press the Remove button. 

To remove all the fertilizers selected, press the Remove All button. 
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Finding the amounts of fertilizers to be applied 

3. After you selected the fertilizers to be used, press the Calculate button. 

    three things happen: 

    a. Smart! finds the best combination of fertilizers, out of the fertilizers you selected, to reach   

        your target values.  

    b. Smart!  calculates the required Fertilizer Application  for each one of  

         these fertilizers. 

     

 

 

     c. A window opens at the top of the screen. This window displays the needed addition of  

         each element, the actual addition calculated and the accuracy of the calculation.  

 

 

 

After you press the Calculate button, you can still change the Fertilizer Application for each 

fertilizer, as well as remove fertilizers from the list or add fertilizers to the list. The displayed 

results will change accordingly. If needed, adjust the values to a result that best fits your 

needs. 

 

The Report  button - press the Report button to see ratios between the elements applied. In 

the Report  form press Details  to see the contribution of each fertilizer to each element. 

To print this report, press the printer icon  on the top left side of the report form. 

You can open and close the report at any time. The report will change interactively as you 

change your input. 
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Congratulations! You have just finished the first step of preparing your optimal recipe. 

You now know which fertilizers to use and what their applied amount to the field should be. 

 

You will now distribute the fertilizers into the fertilizer stock tanks. 

 

Press Fill Tanks  to go to the next screen. 

 

The Fill Tanks screen  

You will now find the number of fertilizer tanks required, distribute the fertilizers into the 

fertilizer stock tanks and find the amount to be used of each fertilizer. 
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1. In the Min. Temp (C°)  box determine the water minimum temperature in degrees 

   Celsius. The temperature you set will determine the solubility of the fertilizers, as in the  

   database. Default value is 5°C. 

 

2. In the Water (m3/Ha/Day) box, enter the daily irrigation water application in cubic meter 

    per hectare (m3/Ha).  

 

3. In the Source Water EC  box, enter your source water EC. 

 

4. You have two options for distributing the fertilizers into the tanks: 

 

    Distributing the fertilizers automatically (Auto Fill Tanks) 

    Distributing the fertilizers manually (Manual Fill Tanks)      

 

a. Distributing the fertilizers automatically  

Press Auto Fill Tanks . Smart! will automatically distribute the fertilizers into the 

minimal number of tanks according to the built-in mixing rules.  

b. Distributing the fertilizers manually  

1. Press the Manual Fill Tanks button. 

2. From the Number of Tanks drop-down menu, select the number of fertilizer 

    tanks you wish to use. The fertilizer tanks will now open below. 
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3. For each fertilizer in the Selected Fertilizers box, check the check-box. From 

the pop-up menu that appears, select Add to tank __ (choose the tank into which 

you want to add the fertilizer) 

4. Repeat the action for all the selected fertilizers on the list. 

 

 

 

If you make a mixing error (i.e. mix incompatible fertilizers), an error message will pop up, 

explaining the problem.  

 

 

 

An alarm sign will be displayed in the tank as long as the problem is not corrected. 
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You can click the alarm sign at any time to view the problem explanation again. 

 

Adjusting the Injection Ratio and the Tank Volume  

After distributing the fertilizers into the tanks, you will now adjust the Injection Ratio and the 

Tank Volume.  

In this example, let's take a look at Tank 1: 

 

Water  – The water quantity in the tank. If you use only solid fertilizers, the water quantity will 

be equal to the Tank Volume . 

 

Total Liquid Fertilizers – The amount of liquid fertilizers in the tank. The sum of the Water  

and the Total Liquid Fertilizers  is the Tank Volume. 

 

Tank Volume - The default value for the Tank Volume is set to 1000 liter. You may change 

this value to the actual tank volume you use. As you change the Tank Volume the quantities  

of the fertilizers in the tank (in the Volume / mass column ) are calculated accordingly 
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. 

 

Injection Ratio  – Smart! calculated the default value for the injection ratio (units of L/m3) 

according to the required concentration of the fertilizers and their solubility. This default value 

is the minimal injection ratio recommended. In case the calculated minimal value is less than 

0.5 L/m3, Smart! sets the Injection Ratio on 0.5 L/m3, due to practical considerations (it is 

unlikely that the fertilizer injector injects less than 0.5 L/m3). 

 

You may change the default Injection Ratio to fit your fertilization system.  The quantities of 

the fertilizers in the tank will be calculated accordingly. 

 

If you set the Injection Ratio to a lower value than the minimal value recommended, an alarm 

will pop-up, explaining the problem that might arise. 

 

 

 

 

Note: The higher Injection Ratio you use, the less concentrated the solution in the tank is, and 

vice-versa. Therefore, to prevent precipitation in the tanks, it is recommended to set the 

Injection Ratio to a higher value than the minimal Injection Ratio calculated. 
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Smart! automatically calculates the estimated EC of the irrigation water.  

Changing the injection ratio will affect the amounts of fertilizers in the tanks, but will not affect 

the EC.  

On the other hand, changing the daily irrigation water quantity (m3/Ha/Day) will affect both EC 

and injection ratio, while keeping the amounts of fertilizers in the tank constant. 

 

Adjust Injection Ratio and Tank Volume in all tanks, according to your irrigation system 

specifications. 

 

Congratulations!  You have just created an optimal recipe, specific to your crop's 

requirements. 

 

Let's see some more options you can use, to adjust the recipe to your specific needs: 

 

The Lock Injection Ratio check box 

 You can use this option when you dilute liquid fertilizers in the tank (mixing it with water), or 

when you mix solid fertilizers together with liquid fertilizers. 
Check this check box to determine the quantities of Water  in the tank and of Total Liquid 

Fertilizers. The injection ratio is determined by Smart! accordingly. 

 

Moving fertilizers from tank to tank  

You can fertilizers from tank to tank at any time. To move fertilizers from one tank to another, 

simply check the check box next to the fertilizer in the tank. A pop-up menu appears, where 

you can select the tank to which you want to move the fertilizer. 

Smart! will pop-up an error message if this action causes a problem. 
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The Default button 

Press the Default button to go back to the default results of Smart! 

 

Changing the Number of Tanks 

You can add or remove tanks at any time. Simply change the number of tanks in the Number 

of Tanks drop-down menu. 

Note that removing tanks, which already contained fertilizers, will bring the fertilizers back to 

the Selected Fertilizers  box. These fertilizers will have to be re-distributed. 

 

Printing your recipe 

To print your recipe, press the Print Recipe button. 

A ready-to-print form will open.  

Press the printer icon  to print. 

 

Saving your recipe 

From the File  menu in the Fill Tanks screen, select Save or Save as. 

In the box opened, enter a name for your recipe. 

Your recipe is now saved. 
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Mixing Fertilizers By Amount – Method 2  

 

In this section you will learn how to find your actual application of nutrients to the field, from 

your fertilizer mix and irrigation system's settings. 

 

From the Mix Fertilizers  menu, select By Amount  > Method 2 . The Select Fertilizers  

screen is displayed.  

 

 
 

Selecting the Fertilizers to be used for the calcul ation  

In this screen you will select the fertilizers available to you, from the fertilizers in the database.  

The fertilizers are divided to liquid fertilizers and solid fertilizers, for convenience purposes. 

 

1. In order to find a fertilizer, you can either use the scroll-down menu or search the fertilizer  

    through the Search Fertilizer box. 
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Note: If the fertilizers you need are not on the list, you can simply add them to the database 

through the New Fertilizer menu (page 42). You can also create your own databases.  

 

2. To select a fertilizer, double click it. The fertilizer will then be added to the 

   Selected Fertilizers box. 

 

 

To remove a fertilizer from the Selected Fertilizers list, click the check box next to the  

fertilizer and press the Remove button. 

To remove all the fertilizers selected, press the Remove All button.  

 

You will now distribute the fertilizers into the fertilizer stock tanks. 

 

Press Fill Tanks  to go to the next screen. 

 

The Fill Tanks screen  

After you selected the fertilizers to be used, you will determine the daily irrigation water 

quantity, distribute the fertilizers into the fertilizer tanks and set the amount of each fertilizer 

and the injection ratio from each tank. You will be then able to produce a full report of your 

nutrient application to the field. 
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Distributing the fertilizers into the tanks 

1. In the Min. Temp (C°)  box Determine the water minimum temperature in degrees 

   Celsius. The temperature you set will determine the solubility of the fertilizers, as in the  

   database. Default value is 5°C. 

 

2. In the Water (m3/Ha/Day) box, determine the daily irrigation water consumption in cubic 

meter per hectare (m3/Ha).  

 

3. In the Source Water EC  box, determine your source water EC. 

 

4. You have two options for distributing the fertilizers into the tanks: 

 

    Distributing the fertilizers automatically (Auto Fill Tanks) 

    Distributing the fertilizers manually (Manual Fill Tanks)      

 

a. Distributing the fertilizers automatically  

Press Auto Fill Tanks . Smart! will automatically distribute the fertilizers into the 

minimal number of tanks according to the built-in mixing rules.  

b. Distributing the fertilizers manually 

1. Press the Manual Fill Tanks button. 

2. From the Number of Tanks drop-down menu, select the number of fertilizer 

    tanks you wish to use. The fertilizer tanks will now open below. 
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3. For each fertilizer in the Selected Fertilizers box, check the check-box. From 

the pop-up menu that appears, select Add to tank __ (choose the tank into which 

you want to add the fertilizer) 

4. Repeat the action for all the selected fertilizers on the list. 

  

If you make a mixing error (i.e. mix incompatible fertilizers), an error message will pop up, 

explaining the problem.  

 

 
 

Entering tanks data: tank volume, fertilizers quant ities, injection ratios 

After you distributed the fertilizers into the tanks, you will now enter the tanks data. 

In this example, let's take a look at Tank 1: 

 

Water  – First, enter the water quantity in the tank. If you use only solid fertilizers, the water 

quantity will be equal to the Calculated Tank Volume . 

 

Fertilizers  Volume/Mass – For each fertilizer in the tank, enter its quantity in the 

Volume/Mass  column (you can use either Kg or grams for solid fertilizers, and Liter or ml for 

liquid fertilizers) 

 

Injection Ratio  – after you entered the water quantity and the fertilizers amounts, enter the 

Injection Ratio  of this tank. 
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Note: As you enter your data, Smart! checks the solubility limitations and calculates the 

reaction between the fertilizers. If a problem arises, Smart! will pop-up a appropriate alarm.  

 

Enter these settings for each one of the tanks. 

Smart! also calculates the Estimated Irrigation Water EC .  

 

 

 

The Report  button - press the Report button to see nutrients application and ratios between 

elements. The report will open in a new window. In the Report  form press Details  to see the 

contribution of each fertilizer to each element. 

To print this report, press the printer icon  on the top left side of the report form. 

You can open and close the report at any time. The report will change interactively as you 

change your input. 
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Printing your recipe 

To print your recipe, press the Print Recipe button. 

A ready-to-print form will open.  

Press the printer icon  to print. 

 

Saving your recipe 

From the File  menu in the Fill Tanks screen, select Save or Save as. 

In the box opened, enter a name for your recipe. 

Your recipe is now saved. 
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Mixing Fertilizers by Amount – Method 3  

 

In this section you will learn how to mix fertilizers according to their applied amounts to the 

field. 

 

From the Mix Fertilizers  menu, select By Amount  > Method 3 . The calculation  screen is 

displayed.  

 

 

 

Selecting the Fertilizers to be used for the calcul ation  

You will now select the fertilizers available to you, from the fertilizers in the database. 

 
Note that you cannot enter data in the Kg/Ha/Day row (the application of each nutrient will be 

calculated later). 

 

 

The fertilizers are divided to liquid fertilizers and solid fertilizers, for convenience purposes. 

 

1. In order to find a fertilizer on the list, you can either use the scroll-down menu or search the 

    fertilizer through the Search Fertilizer box. 
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Note: If the fertilizers you need are not on the list, you can simply add them to the database 

through the New Fertilizer menu (page 42). You can also create your own databases.  

 

 

2. To select a fertilizer from the list, double click it. The fertilizer will then be added to the 

   Selected Fertilizers box. 

 

To remove a fertilizer from the Selected Fertilizers list, click the check box next to the  

fertilizer and press the Remove button. 

To remove all the fertilizers selected, press the Remove All button. 

 

Calculating the nutrients application  

For each of the fertilizer you selected enter the daily amount to be applied. The units are 

Kg/Ha for solids, and Liter/Ha for liquids. 

 

 

 

The daily amount applied of each nutrient is instantly calculated and displayed in the table at 

the top of the screen. 
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Each of the macro nutrients (N, P, K, Ca, Mg ,S) has a drop down menu. Open the drop down 

menu to select the form of each element (e.g. P or P2O5, N-NO3 or NO3). 

 

 

Note that changing the units  or the form  of the elements will automatically convert the value 

you entered accordingly. 

 

 

The Arrange button - Clicking the Arrange  button will arrange the selected fertilizers in a 

convenient order to facilitate further calculations. Fertilizers which contain a nutrient that other 

fertilizers do not, will appear at the top of the list. 

 

The Report  button - press the Report button to see ratios between the elements applied. In 

the Report  form press Details  to see the contribution of each fertilizer to each element. 

To print this report, press the printer icon  on the top left side of the report form. 

You can open and close the report at any time. The report will change interactively as you 

change your input. 

 

 
 

Congratulations! You have just finished the first step of preparing your optimal recipe. 

 

You will now distribute the fertilizers into the fertilizer stock tanks. 

 

Press Fill Tanks  to go to the next screen. 

 

The Fill Tanks screen  

You will now find the number of fertilizer tanks required, distribute the fertilizers into the 

fertilizer stock tanks and find the amount to be used of each fertilizer. 
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1. In the Min. Temp (C°)  box determine the water minimum temperature in degrees 

   Celsius. The temperature you set will determine the solubility of the fertilizers, as in the  

   database. Default value is 5°C. 

 

2. In the Water (m3/Ha/Day) box, enter the daily irrigation water application in cubic meter 

    per hectare (m3/Ha).  

 

3. In the Source Water EC  box, enter your source water EC. 

 

4. You have two options for distributing the fertilizers into the tanks: 

 

    Distributing the fertilizers automatically (Auto Fill Tanks) 

    Distributing the fertilizers manually (Manual Fill Tanks)      

 

a. Distributing the fertilizers automatically  

Press Auto Fill Tanks . Smart! will automatically distribute the fertilizers into the 

minimal number of tanks according to the built-in mixing rules.  

b. Distributing the fertilizers manually  

1. Press the Manual Fill Tanks button. 

2. From the Number of Tanks drop-down menu, select the number of fertilizer 

    tanks you wish to use. The fertilizer tanks will now open below. 
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3. For each fertilizer in the Selected Fertilizers box, check the check-box. From 

the pop-up menu that appears, select Add to tank __ (choose the tank into which 

you want to add the fertilizer) 

4. Repeat the action for all the selected fertilizers on the list. 

 

 

 

If you make a mixing error (i.e. mix incompatible fertilizers), an error message will pop up, 

explaining the problem.  

 

 

 

An alarm sign will be displayed in the tank as long as the problem is not corrected. 

 



 ��

 

 

You can click the alarm sign at any time to view the problem explanation again. 

 

Adjusting the Injection Ratio and the Tank Volume  

After distributing the fertilizers into the tanks, you will now adjust the Injection Ratio and the 

Tank Volume.  

In this example, let's take a look at Tank 1: 

 

Water  – The water quantity in the tank. If you use only solid fertilizers, the water quantity will 

be equal to the Tank Volume . 

 

Total Liquid Fertilizers – The amount of liquid fertilizers in the tank. The sum of the Water  

and the Total Liquid Fertilizers  is the Tank Volume. 

 

Tank Volume - The default value for the Tank Volume is set to 1000 liter. You may change 

this value to the actual tank volume you use. As you change the Tank Volume the quantities  

of the fertilizers in the tank (in the Volume / mass column ) are calculated accordingly 
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. 

 

Injection Ratio  – Smart! calculated the default value for the injection ratio (units of L/m3) 

according to the required concentration of the fertilizers and their solubility. This default value 

is the minimal injection ratio recommended. In case the calculated minimal value is less than 

0.5 L/m3, Smart! sets the Injection Ratio on 0.5 L/m3, due to practical considerations (it is 

unlikely that the fertilizer injector injects less than 0.5 L/m3). 

 

You may change the default Injection Ratio to fit your fertilization system.  The quantities of 

the fertilizers in the tank will be calculated accordingly. 

 

If you set the Injection Ratio to a lower value than the minimal value recommended, an alarm 

will pop-up, explaining the problem that might arise. 

 

 

 

 

Note: The higher Injection Ratio you use, the less concentrated the solution in the tank is, and 

vice-versa. Therefore, to prevent precipitation in the tanks, it is recommended to set the 

Injection Ratio to a higher value than the minimal Injection Ratio calculated. 
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Smart! automatically calculates the estimated EC of the irrigation water.  

 

Changing the injection ratio will affect the amounts of fertilizers in the tanks, but will not affect 

the EC.  

On the other hand, changing the daily irrigation water quantity (m3/Ha/Day) will affect both EC 

and injection ratio, while keeping the amounts of fertilizers in the tank constant. 

 

Adjust Injection Ratio and Tank Volume in all tanks, according to your irrigation system 

specifications. 

 

Congratulations!  You have just created an optimal recipe, specific to your crop's 

requirements. 

 

Let's see some more options you can use, to adjust the recipe to your specific needs: 

 

The Lock Injection Ratio check box 

You can use this option when you dilute liquid fertilizers in the tank (mixing it with water), or 

when you mix solid fertilizers together with liquid fertilizers. 

Check this check box to determine the quantities of Water  in the tank and of Total Liquid 

Fertilizers. The injection ratio is determined by Smart! accordingly. 

 

Moving fertilizers from tank to tank  

You can fertilizers from tank to tank at any time. To move fertilizers from one tank to another, 

simply check the check box next to the fertilizer in the tank. A pop-up menu appears, where 

you can select the tank to which you want to move the fertilizer. 

Smart! will pop-up an error message if this action causes a problem. 
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The Default button 

Press the Default button to go back to the default results of Smart! 

 

Changing the Number of Tanks 

You can add or remove tanks at any time. Simply change the number of tanks in the Number 

of Tanks drop-down menu. 

Note that removing tanks, which already contained fertilizers, will bring the fertilizers back to 

the Selected Fertilizers  box. These fertilizers will have to be re-distributed. 

 

Printing your recipe 

To print your recipe, press the Print Recipe button. 

A ready-to-print form will open.  

Press the printer icon  to print. 

 

Saving your recipe 

From the File  menu in the Fill Tanks screen, select Save or Save as. 

In the box opened, enter a name for your recipe. 

Your recipe is now saved. 
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The File Menu 

 

The File menu allows you to manage files of saved recipes as well as fertilizers inside the 

database you are currently working with. 

 

Through this menu you can open or delete saved files, add new fertilizers to the database, 

edit fertilizers which you previously added and delete fertilizers from your database. 

 

Opening A Saved File (A Recipe) 

 

1. From the File menu, select Open File . A dialog box opens. 

2. From the drop down menu box, select the file you wish to open. 

3. Press the Open button. 

 

Your previously saved recipe will open. 

 

Adding A New Fertilizer To The Database 

 

You can easily add new fertilizers to the database. The fertilizers you add will participate in all 

the calculations and will follow the mixing rules.  

For optimal  performance and accuracy of calculations, it is recommended to enter all the 

required data. 

 

Entering Basic Information 

1. From the File menu select New Fertilizer > Fertilizer .  The New Fertilizer window 

opens. 

 

2. In the Name of Fertilizer box, enter the name of the new fertilizer you want to add. 

1. From the State drop down menu, select Solid or Liquid. 

a. For a Solid fertilizer, enter the solubility data at different temperatures. 

b. For a Liquid  fertilizer enter:  

i. the Specific Weight  of the fertilizer in Kg/l. 

ii. the Crystallization Temperature (in OC). 

2. Enter pH of the fertilizer (optional). 
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3. In the Manufacturer box, enter the name of the fertilizer's manufacturer. 

 

Entering Content Of The New fertilizer 

1. Use the fertilizer's label, and enter for each element its percentage in the fertilizer.  

    Note the form of each element (e.g you can enter either P or P2O5). 

 

 

 

For acids and for liquid fertilizers with acidifying properties, use the L/m3 Neutralizes 1meq/L 

HCO3 box.  

 

2. For the micro elements (Fe, Mn, Zn, Cu, Mo, B), enter the concentration in mg/Kg (=ppm), 

     or in percentage. For liquid fertilizers there is also the option of g/l. 

    If the micronutrients are in the chelated form, check the checkbox above this section.  

 

 

 

Saving Your Fertilizer 

To save the data you entered, press the Save button. If all the necessary information was 

entered, a confirmation message will be displayed: Information Saved!  

 

 

Note that if you press the New button before saving your fertilizer, all the entered data will be 

erased. 
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Editing A Fertilizer's Data 

 

Smart! allows you to edit the data of a previously added fertilizer, modify their information or 

add new data. 

 

1. From the File  menu, select Edit Fertilizer .  

2. Select the state of the fertilizer you want to edit (Liquid Fertilizer/Solid Fertilizer ). 

3. From the Search Fertilizer by Name drop down menu, select the fertilizer to be 

edited. 

4. The data can be entered, deleted or modified in the same way as in the Add New 

Fertilizers  section (page 58). 

 

Updating Your Fertilizer 

 

 

 

To update your fertilizer press the Update button.  A confirmation message will be displayed. 

 

Note:  The default fertilizers of the software cannot be edited. 

 

Deleting A Fertilizer From The Database 

 

1. From the File Menu , select Delete Fertilizer . 

2. Select the type of fertilizer to be deleted (Liquid Fertilizer/Solid Fertilizer/Liquid  

    Chelate/Solid Chelate ). 

3. From the drop down menu, select the fertilizer to be deleted. 

4. Press the Delete button. 

 

Deleting A File (A Recipe) 

 

1. From the File Menu , select Delete File . A dialog box opens. 

2. From the drop down menu select the file to be deleted. 

3. Press the Delete button.  
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The View Menu 

 

In the View menu you can view the data of each of the fertilizers included in the database. 

 

1. From the View menu select Fertilizer Data .  A new window opens. 

2. From the State drop down menu, select the state and type of the fertilizer you want to view. 

3. From the Search Fertilizer by Name drop down menu select the fertilizer you want to  

    view. 

 

All the information of the fertilizer is displayed.  

 

You can select the form of each element (e.g. N-NO3 or NO3). 

 

The micro elements can be viewed in different units, such as percentage, mg/Kg and g/l. 
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The Database Menu 

 

For your convenience Smart! allows you to create different databases. These databases 

include the fertilizers and the files you have saved. Fertilizers and files saved in a specific 

database will only show up when using this database. 

 

Create A New Database 

 

1. From the Database menu, select Create New Database . A dialog box opens. 

2. In the Database Name  box, enter the name of your new database. 

3. To start working with your new database, check the Change Working Database   

    checkbox. 

4. Click the Save button to save your database. 

 

Open A Database 

 

1. From the Database menu, select Open Database.  A dialog box opens. 

2. Select the database you want to open. 

3. Click the Open button. 

 

 

 

Delete A Database 

 

1. From the Database  menu, select Delete Database . A dialog box opens. 

2. Select the database to be deleted. 

3. Press the Delete button. 

Note that you cannot delete the default database. 

 


